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Purging Teleform Files 

 

Teleform maintains several files that aren’t visible in Reader, Verifier, or ScanStation.  It tracks things like completed 

batches, reader statistics, export statistics, and scanned images.  If not purged periodically, Teleform processing time 

can slow considerably.  When you’re doing a lot of scanning, it’s a good idea to purge files daily when there are no 

batches waiting correction.   

The purge will remove Teleform statistics, stored images of documents that were evaluated ok, and completed batches. 

To perform a purge: 

1. Open Teleform Reader. 
2. Select ‘Utilities’ at the top of the form, then ‘Purge Log’ in the drop-down menu. 
3. The following screen appears.  Check the boxes as shown in the image below.  Click ‘Purge Now’. 
4. Teleform will purge all checked files. 

 

Purges can also be done automatically by selecting the ‘Automatic’ box and entering a number of days.   
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 Default Teleform Settings 

 

Open any Teleform module.  At the top of the page, click ‘Utilities’, then ‘Configuration’.  The 

‘Global and Local Teleform Settings’ window will open.  Make sure the settings match those 

shown below. 

 

Reader Settings 

Click on the Reader tab, then the various sub-tabs. Make sure the settings are exactly as shown. 

Recognition Tab      
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OCR Performance Tab 
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General Tab 

 

 

 

 

 

 

 

 



7 
 

 

Global Systems Settings 

Click on the Global System tab, then the various sub-tabs. Make sure the settings are exactly as shown. 

General Tab          
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Export Tab 
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Configuration Options Settings 

Click on the Option drop down menu and select ‘Enable Scripts’.  Make sure the ‘Enable’ box is checked. 
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Verifier Options Settings 

Open Teleform Verifier.  On the top of the screen, click on ‘Options’, then ‘Form Mode’.  Make sure options are 
checked as shown below. 
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The default color for highlighting a student response is blue, which sometimes is hard to see.  Change the color to red to 
make it more visible.  Click on the ‘Appearance’ tab, then select ‘Choice/Entry Field Mark’ in the drop-down Colors 
menu.  Click the color drop-down and select red. 

 

 

All other Teleform settings are optimized for best performance.  Do not make any other changes to settings. 
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Set up Teleform Forms/Delete Old Teleform Forms 

Importing Teleform Forms 

­ Open Teleform Designer.  Select ‘File’, then ‘Templates’.  
­  A list of Template folders appears. 
­ Right-click on the main ‘Template’ folder and create a new folder for the forms being set up (Example: Regents 

Jan 2019). 
­ Right-click on the folder you just set up and select ‘Import’. The ‘Import’ window opens. 

  
­ Make sure ‘Preserve auto exports’ is checked. This is critical; if not checked your export files won’t be saved. 
­ Leave other settings as shown. 
­ In the ‘From Directory’ box, browse to where you downloaded the Teleform .tft files, then click OK. 
­ A list of the .tft files appears under Templates.  Highlight all of the tft files, click Import.   
­ The forms will show in the Templates folder you created. 

 

Delete Old Teleform Forms 

It’s a good idea to delete old forms; the Teleform system will run quicker with fewer forms defined. 

­ Open Teleform Designer.  Select ‘File’, then ‘Templates’.  
­  A list of Template folders appears.  Select the folder containing forms to be deleted. 
­ Select the form to be deleted, then right-click and choose ‘delete’. 
­ Enter the password if prompted, click OK.  The form will be deleted.  
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Set up Scan Station Job Configuration 
 

Open Teleform Scan Station.  (To enter a new Regents Exam) 

­ Define Job Setting for the form:  Click on File, Job Configuration.   
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- Then click on the ‘New’ button.  The Job Properties dialog box opens.   
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- - Under the ‘General’ tab, enter the test name in the Job name field.   
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­ Under the ‘Review/Export’ tab, uncheck ‘Allow auto-commit’. 
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­ Under the ‘Form Id/Capture’ tab: 

­ In the ‘Expected types’ drop-down menu, select ‘Forms Only’.  In the ‘Identification’ drop downs, select 

‘Evaluate all images as’ and the form that is being set up.  The rest of the settings will populate based on 

Identification settings.   
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­ Click on the ‘Page Handling’ tab.  Check the box labeled ‘Defer linking until all pages have evaluated’ if not 

already checked.  Click ‘OK ‘ at the bottom of the window.  (If blank pages will be scanned, also check ‘Check for 

and remove blank pages’.)   Scanner job settings are now complete. 
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Scanning and Verifying 

Before Scanning: 

 Review all walk-in answer sheets: 
- The district and building must be written in at the top of the first page. 
- The student ID number must be written at the bottom of the first page and top of the second page. 
- The student ID name must be written at the top of the first page and top of the second page. 
- Look the student up in Level 0 to verify that the student ID number is correct. 
- Fill in the vertical lines on the BedsCode barcode at the page bottom (right under ‘Do not write on barcodes’) 
- Look up the school BedsCode.  Write in above the BedsCode barcode. 
 

 List the districts and schools included in the batch on the Batch Cover Page.  This will make it easier to process the 
scanned batches in ASAP. 
 

You must first make sure you have the following folders set up on your C drive: 

 Create a folder named MAARS 

 Inside the MAARS folder create one more folder with the following name 
o Regents 

 
 

Prior years' scanned files 

If there are old files in the C:\MAARS\Regents folder, delete or move to another folder if you want them retained. 
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 Scanning a Batch:   (For MAARS: DO A BATCH COVER SHEET!) 

1. Open and Enable Teleform Reader.  (See Teleform Reader directions) 
2. Start Scan Station. The main screen appears. 
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3. Click the ‘New Batch’ icon on the top left screen of the Scan Station. 
 The ‘New Batch’ window opens.   

 

- In the ‘Details’ Tab, Click the Job dropdown.  Select the test to be scanned. 
- In the ‘Tracking Id’ window enter a name for the job.  The name can be anything that would help identify the 

batch. (MAARS: Write Track ID on the Batch Cover Sheet)  
- Enter a user name in the Operator window. 
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4. Click the ‘Process’ tab.  

- To scan from a scanner connected to the desktop: Click in the ‘Source’ drop down box and select the scanner.  
Do not change any other settings.  FEEDER=Front and Back  

- To scan from a file on a network:  Click in the ‘Source’ drop down box and select ‘Directory’.  In the ‘Directory’ 
window, enter the path to the folder containing scanned images. 

- Click ‘Start’.  The scanner will start scanning. 
 

 

- Form images display as they are being scanned.  
- When scanning is finished, click the ‘Accept’ button below the window of scanned images.  This will send the 

images to the Reader to be processed.  (Note: The ‘Continue’ button is only used if you have more sheets you 
need to scan into the batch.) 
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Reading Scanned Images 

Start Teleform Reader.  The main window opens.  

1. The Teleform Reader module will automatically start reading the images if it is open and enabled.  

 The ‘Enable’ icon is the box with a green triangle and red box.  If the icon is gray, there will be an  
‘Evaluations disabled’ message in the Message area.   

 Click on the icon to enable the Reader, and it will start reading.   
 You can click on the button to stop the Reader, and then click again to start again. 

 

2. The Reader will just keep reading images in the batch until the end.  No user action is necessary. 
 

3. Before closing the Reader, it’s a good idea to click the Enable icon to turn it off.  Otherwise Reader will start 
looking for images whenever it is opened. 
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Verifying Scanned Images 

 

       Start Teleform Verifier.  The main window opens. 
 
 

 

 

 There are two ways to view data in the Verifier:  
1.  The ‘Batch Management’ displayed above shows all batches that have been processed through the Reader.  

The Status column shows whether the batch is being evaluated by the Reader (Ready for Evaluating, 
Evaluating, Ready for Correction, Ready to Commit, Batch is Complete). 

o To correct errors in a batch, double click on the batch.  
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2. The ‘Image Management’ shows all images waiting correction for a form.  The view is changed by selecting 
‘Image Management’ from the ‘Utilities’ dropdown menu at the top of the screen.  This view is usually used 
only when an answer sheet was bookmarked due to missing scores. 
 
 

 

3. The Verifier will display answer sheets that need correction.   

 Item responses in question will show a highlighted bar across the responses and Teleform ‘best guesses’ 
highlighted.   

 You can click the Tab button to accept the Teleform choice or change the value by clicking in the correct 
choice or by entering the value in the check box in the bottom window.  Click Tab to make the change.  

 Be careful not to click in a circle twice.  This will remove the response! 
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 If a response or score is missing, the following message will appear.  

 For multiple choice questions, click on the ‘Accept value and set field status to OK’ choice.  The student 
response will remain blank.   

 Continue verifying the answer sheet. 
 

 

 If a student ID is missing, enter the ID preceded by 3 zeros. 

 All blank answer sheets preprinted with ZZZZZZZZZ (or no ID for forms based on a former Regents form) 
will come up as missing pages.  As soon as the matching ID’s are entered for both pages as you verify, 
the “missing” message will go away! 

 
 

 

 For constructed response or essay questions, the teacher score must be found.   
 Click cancel.  
 Then click on the pushpin icon on the top of the page.  The ‘Hold for Research’ window will appear.   
 Click ‘OK’ to accept.  
 Make note of the student ID and the error.  
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 After the batch has been verified, all records held for research will remain as ‘Needs Review’ and the 
batch status will be ‘Ready for Correction’.  To view these records, switch to the Image Management 
dialog.  All bookmarked answer sheets will display with the pushpin icon. 
 

 After corrections have been found for all bookmarked answer sheets, switch back to the Batch 
Management dialog, select the batch, and make the corrections.   

 If an error on an answer sheet can’t be resolved in the Verifier, it can be deleted.  Switch to the 
Image Management dialog.  Right click on the image(s) and select ‘Remove from Batch’. 

 

4. When all corrections for an answer sheet have been made, the next answer sheet to be corrected will appear. 
 

5. When all errors have been corrected, the Batch Management screen appears.  The batch will show as ‘Ready 
to be committed’. Right click on the batch and select ‘Commit’.   

 

6. The data file will be added to the following folder:  ‘C:\MAARS\Regents’ folder on the Teleform computer. 
Change the ‘dddd’ in the file name to indicate the summer school location. Example: The Global History file 
name is ‘AU12GLdddd.csv’.  Change to ‘AU12GLSSPitt’. Do not open the file in Excel; it will be reformatted.  
This is the file that will be imported into ASAP.  If it’s necessary to scan additional answer sheets after the 
batch has been committed, a new file will be created.  Change the second file name to a unique name like 
‘AU12GLSSPitt2’ 

 
7. To change a bubble you previously verified, go to “Image Management”.  

 Select “Batch & Form” 

 Double click on each answer sheet until you find the one you want. 

 Double click on the question and you can change it. 
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8. To remove blank sheets: Go to “Image Management”. Right click on blank sheets and select “Remove from 
Batch”. 
 

9. If someone else commits your batch, it resides on their computer and it processed with their batches, not 
yours.  When this happens, you will need to rescan and go through the process again.  You will need to 
rename the file (JA...) in the MAARS Regents folder where the scans go first. Then scan & verify. Upload newly 
named file (where those scans went) to ASAP.  We need to track all batches and make sure you are the one 
that committed it as well as making sure you only commit your batch. 
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Teleform Designer Basics updated 

Designer Environment 

   

 The top line displays information about the current open form. 
 

 Toolbar buttons contain shortcuts to commands that are also available from the menus. 
 

 The Field Window shows on the left of the window.  All defined fields are listed in the order added to the form. 
 

 The Design Window on the right is a ‘pasteboard’ for designing a form. 
 

 Setting View Options.  Chose ‘Options’ from the ‘View’ menu.  Several grid options are available to assist in 
visually lining up objects on the form.  Grid units, size, and style may be modified.  The default ‘Snap to Grid’ 
option forces objects to align with the grid. 

 

 Clipboard.  Chose Cut, Past, Undo, Redo from the ‘Edit’ menu or Toolbar. 
 

 Form Objects.  There are two kinds of form objects: 
- Non-Data:  Text and Shapes (lines, rectangles, elipses, graphics) 
- Data fields: 

 Choice Fields.  All question response fields on NYS forms are Choice fields with response letters in the 
bubbles. 

 Image Zones.  An outlined area on the form that allows for the capture and evaluation of responses or 
images. They may contain barcodes, machine printed data, written text, and drawn images.  All MAARS 
forms use Image Zones to print barcodes of student ID, Bedscodes, and Page Link fields because they 
rarely require verification.   

 Entry Fields:  Another type of bubble field not used on NYS forms. 
 Constrained Print:  Print fields with one space bounded by lines for each character in a response.  This is 

sometimes used to enter a name or address. 
 Capture Zone: Used for keying information such as an essay or survey response. 
 Virtual Fields: Used for linking pages and for form scripting.
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Working in the Designer Workspace 
 

 Creating a new form. 
- Open Teleform Designer. 
- Select File -> New -> Form -> Traditional -> Finish. 

 

 Adding and Modifying Text. 
- Click on the colored ‘A’ text icon on the toolbar or select ‘Text’ from the ‘Shape’ Menu. 
- Set the font by clicking on the Font icon on the toolbar. 
- Position the cursor on the form, press the left mouse button, and draw a rectangle to define the text area.  

Type the text in the rectangle. 
 

 Adding and Modifying Shapes. 
- Choose the shape from the ‘Shape’ menu or toolbar. 
- Position the cursor on the form, press the left mouse button, and draw the desired shape. 
- Define the Line/Fill Properties.  The line width default value is 15/1000ths of an inch.  You can type any value 

between 1 and 200 in the ‘Line width’ box. 
- Click ‘OK’ to save the new shape. 

 

 Working with Shapes.   
- Sizing: Resize the shape as needed by clicking on the shape.  Use the ‘handles’ to adjust the size.   
- Moving: Click on the shape and drag the shape to move it.  To move a group of shapes together, draw a box 

around them, and then drag to the new location. 
- The Teleform Shape Library contains some common shapes that can be pasted to the form, saving the need to 

draw a new shape.  New shapes can be added to the library for use in other forms.  For example, a district 
name header could be added to the library, then used for every form created in the district. 

 To copy an existing shape: Select ‘Library’ from ‘Shape’ menu.  Click on the shape to be copied, select 
copy, then paste it to the form. 

 To add a shape to the Shape Library, click on the shape and select ‘Copy’.  Open the Shape Library.  Click 
on the ‘Items’ folder and select paste.  You could create your own folders here if needed.  The item will 
be saved as ‘Current Selection’.  Change the name to reflect the field. 
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Creating a New Form using an Existing Form 

 

Creating a new form using an existing form is the easiest way to create a new form.  This involves the following steps: 

opening a form, changing or removing text, adding or removing questions, and changing the export file layout to match 

the questions on the form. 

 

MAARS forms for NYS 3-8 assessments and Regents exams may be used to create forms for most testing needs.  

Components of the form can include question responses and district, teacher, and student information.  The student ID 

number is used to link multiple pages. 

The forms also contain scripts written to deal with hand-written student ID numbers.  Make sure not to change the 

student ID field name or the hand-written numbers won’t be read. 

 

1. Open Teleform Designer. 
 

2. Select ‘File’, ‘Open’, then click on the form to be used. 
 

3. Click on ‘Save As’ from the ‘File’ menu.  The form shown below opens. Enter a new name for the form.  If using the 
Testing Database, the Form ID must be a 5-digit unique number. To avoid conflict with MAARS Form ID numbers, 
add ‘1’ or ‘2’ to the beginning of the form ID shown. To save the form to a different folder, click the ‘Select’ button 
to choose the template folder. 

 

 

 

4. To remove unneeded objects, draw a box around the items and press the delete key. 
 

5. To change text fields, double click on the object and enter text.  The font may be changed by clicking on the Font 
icon.  
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6. To move multiple fields, draw a box around them, click on the box, and move.  You can move entire blocks of 
questions or text together. 

 

7. To move individual objects, click and hold the mouse on the object and move to the desired location.  Be careful 
moving question responses.  The response objects on MAARS forms consist of two objects: the response bubbles 
and text overlaying the bubbles.  To move both together, draw a box around the responses and drag to move.  You 
can move them individually as well, but it’s harder to align them. 

 

8. When modifying a form with multiple pages, you may want to delete one or two pages.  To delete a page, go to the 
page to be deleted, select ‘Edit’, then ‘Delete Page’. 

 

9. To add a page, select ‘Edit’, the ‘Add Page’, then select where you want the page to be added. 
 

10. When there are multiple pages, you may want Image Zone data like student ID, teacher, or building to print each 
form.  To repeat these fields that were created on the first page, copy the field.  Double click the field and the Field 
Properties box opens. Click on ‘Appearance’, then ‘Prefill’.  Enter % + the field name from the original field + %.  For 
example, to print the student ID field from Page 1 on Page 2, you would enter %StdID%.  The same field in the pre-
print database will be used, eliminating the need for multiple fields. 
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11. When you’ve finished setting up all the objects on the form, you’ll need to change field names on the new fields and 
possibly original fields if their sequence on the form changed.  In the Fields Menu on the left of the screen click on 
each field.  Make sure the field name matches the question on the page.  If it needs to be changed, double click on 
the field and the Field Properties window opens.  Type a field name in the Field ID. 

 

 

12. You may also need to set the validation rule for constructed response or essay fields.  The MAARS forms have ‘Entry 
Required’ turned off on these fields because our processing database will catch any missing scores.  It would be a 
good idea for you to require these fields to be bubbled.  Double click on the field, select the ‘Validations’ tab, and 
click the ‘Entry Required’ box.  Do not check this box for multiple choice fields. 
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13. When cutting and pasting fields on the form, Teleform adds them to the field list in the order they were placed on 
the form.  This may not be the order they appear on the form.  You will need to change the sequence of the fields in 
the field list and the tab order. 

- Select ‘Form’, then ‘Fields’ from the menu bar.  The ‘Fields’ window displays. 

 

 

- The ‘Fields’ window shows all fields on the form. Ignore the Teleform system fields.    Review the form fields 
to make sure they are all in the correct order.  If some are out of order, select a field and press the Up or 
Down button until the order is correct. 

- Select the ‘Tab Order’ tab.  This defines the sequence that fields are presented for correction in the Verifier.  
Click on the ‘Copy Field Order’ button the match the sequence of fields in the fields window, or select a field 
and click Up or Down to select the position. 

 

 

 

- When the fields are all in order, click ‘OK’ to save. 
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14.  Set up the AutoExport file.  This is the file that Teleform will create when a batch has been committed.  This file can 
contain any of the fields on the Teleform form.  It can also contain Virtual Fields that may have been created by 
scripts written for the form.  You define the fields that you want to collect.  To set up the file: 

 

- Select ‘Form’, then ‘AutoExport Setup’ from the menu bar.  The AutoExport Setup window appears.  Click on 
the ‘New’ Button. 

 

 

- The AutoExport file type is defined in the next window.  Although there are a variety of file formats available, 
it’s best to either create a CSV file or link to an Access Database table.  Select the desired file type.  Click the 
‘Save As’ button and enter the file path and name of the file to be created. 
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15. Click on the Fields tab.  Fields to be included in the export file are defined in this window.  
- Check the fields you want in the file and make sure the ones you don’t want are unchecked.  You can check or 

uncheck a group of fields by selecting them and clicking once. 
- Review the order the fields are shown.  This is the order they will appear in the file.  To move a field, click at 

the top of the gray box next to the field and drag the cursor.  A red line should appear.  Drag this line to the 
position where you want to move the field. Make sure to check the sequence of the question response fields 
in the file.  If you’ve moved questions around on the form, they could be out of order here.  When all fields 
are in order, click ‘OK’. 

 

 

- You’ll be back to the main AutoExport Setup window.  Check the ‘Enable’ and ‘Fail Commit if this Export Fails’ 
button.  Click on ‘OK’ to return to the form. 

 

16. Activate the form.  Click on ‘Form’, then ‘Activate’.  Follow prompts to activate the form. 
 

17. Save the form. Click on the Save icon or select ‘File’, then ‘Save’ from the menu bar. 
 

 

 

 


